Word 2008: Revising a document
Learning Guide
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Why use Word'’s revision tools?

Word’s editing tools are a great way to collaborate with others on
projects. While people still fax each other hardcopies of
documents and mark them up with a red pen (or struggle to
organize a series of changes to a document emailed back & forth
between collaborators), Word makes it possible for you to
complete and manage all your edits within your document. This
also eliminates the work of incorporating and retyping the
suggestions of various collaborators.

Word offers two great editing tools to aid you in your
collaborations:

Track Changes

With this tool, multiple reviewers can make changes or additions
to a single document. Word tracks each insertion, deletion, or
formatting change made to the document by each collaborator.
Referring to these highlighted changes as Markup, Word uses
color to distinguish them from the original text. As you review
tracked changes, you can accept or reject each change by
highlighting the markup and choosing accept or reject.

Compare and Merge Documents

With this tool, several reviewers can edit a document
simultaneously. During revisions, each reviewer makes a copy of
the document and makes his or her changes. At the end of the
revision process, all of the copies can be merged into a single
document containing all of the edits. When you compare and
merge the documents, Word will show what you and your
reviewers added and/or changed. From there, you can accept or
reject the additions and changes to the original document.




Getting started with your revisions

Enabling Track Changes

To view changes made to you or your colleague’s document as you

edit:

e Open the document you wish to edit.

e From the View menu, go to the Toolbars section and click on
Reviewing.

Elements Gallery

Toolbars L « Standard
Customize Toolbars and Menus... Formatting
MNavigation Pane Contact

v Reviewing
Tables and Borders |

e Word’s Reviewing toolbar will appear below the Standard
toolbar.

Final Showing Markup Show ¢,-,= a "yz xg,'ﬂ

Reviewing toolbar

e Click on the Track Changes button to begin tracking your
changes.

e Type your changes as you would into any document.

e As you make edits to the document, Word highlights the edits
in colored underlined text, and inserts a revision bubble for
each formatting change.

| This is a new sentence.

Sample of new text.

This is a new sentence.

i 216/08 11:29 AM

| Formatted: Font:Bold

Sample of text reformatted to Bold
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Displaying revisions in your document

By default, Word shows your edits in the final document using
underlined, colored text. However, you can opt to display your
revisions without the colored markup annotations, or you can
display the original version of your document.

To change the way your edits are displayed in your document:
e Locate the Display for review button on the Reviewing
toolbar.

Final Showing Markup Fk = Shows
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| Display for Review |

e Click on the down-facing arrow next to the box labeled Final
Showing Markup.
e Select the type of markup you wish to apply to your document.

- Final Showing Markup
Final
Original Showing Markup

Original

ITS helps people understand how to effectively use/computer
programs.

2/6/09 11:46 AM

LCummerlt: Inserted Tet

[2/6/09 11:46 AM
Formatted: Font:Bold

In the above example, Final Showing Markup has been selected

The Display Option Results

Final Showing Markup Word's default choice. This option
displays the revised version of your
document, identifying all revisions using
colored text. Any deleted text will appear
in revision bubbles at the right of your

text. Al of the screen images in this guide were
captured using the Final Showing Markup option.

Final This option incorporates all revisions into
the text of the document. No markup is
used to distinguish the revisions from the
original text.

Original Showing Markup | This option displays the original text of
the document, with inserted text in
revision bubbles at the right of your text.
Deleted text is marked with strike-
through formatting.

Original This option doesn't display any edits.
Only the original text is shown.
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Tip: For best results, use either the Final Showing Markup or the
Original Showing Markup option to view the markup in your
document.

Accepting and rejecting revisions

Once you have a document with edits in colored text, you can
review the revisions and prepare a final draft by accepting or
rejecting the changes that were made.

Accepting a revision

e Click on the revision (shown in colored, underlined text) or its
corresponding revision bubble.

e From the Reviewing toolbar, click on the Accept Change
button.

22 Accept Change

Accept All Changes Shown

Accept All Changes in Document

e A rrevision that you accept will be included in the final draft of
the document. Its color will change to match that of the
surrounding text.

Rejecting a revision

e Click on the edit (shown in colored, underlined text) or its
corresponding revision bubble.

e From the Reviewing toolbar, click on the Accept Change
button.

"a:g.e_iect Change/Delete Comment

Reject All Changes Shown
Reject All Changes in Document
Delete All Comments Shown

Delete All Comments in Document

e The edited text will be removed from the document and will be
excluded from the final draft.
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Navigating between your edits

It can often be challenging to find all of the edits that your
collaborators have made to a long document. Word provides tools
to help you find all of the changes that have been made.

e To move to the next revision in the document, click on the
Next button located on the Reviewing Toolbar.

e To move to the previous revision in the document, click on the
Previous button located on the Reviewing Toolbar.

&

Accepting and rejecting all revisions in a document

If you are sure that you want to accept or reject all of the revisions
made to your document, Word allows you to do so without
reviewing each individual change.

Accepting all the changes in a document

e From the Reviewing toolbar, click on the down-facing arrow
next to the Accept Change button.

e From the menu that appears, select Accept All Changes in
Document.

6_:;2' Accept Change

Accept All Changes Shown

Accept All Changes in Document |

Rejecting all the changes in a document

e From the Reviewing toolbar, click on the down-facing arrow
next to the Reject Change button.

e From the menu that appears, select Reject All Changes in
Document.

% Reject Change/Delete Comment

Reject All Changes Shown




Adding comments to a document

Sometimes you will not want to directly change another person’s

document, but respond to their content. In cases like this, you can

add a comment in the margin of a document — just as you would

when reviewing a printed document. To add a comment to a

document:

e Place your cursor in the area of the document where you wish
to place a comment.

e Click on the New Comment button located on the Reviewing
toolbar.

l@ New Cﬂmm:':ntﬂ

e A comment bubble will appear in the margin of the document.

2/6/09 12:05 PM
Comment:

e Type your comment in the bubble.

2/6/09 12:09 PM (3]
Comment: Shouldn’t we add a section about
, adding comments to a document?

e When you are finished writing your comment, click outside the
comment bubble and continue editing the document.
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Editing and Deleting Comments
Before sending a document you edited to your colleague, you may
need to edit or delete some of your comments.

Editing a comment
e Click inside the revision bubble you wish to edit.
e Edit the text as you would edit text in a Word document.

Deleting a comment

e Click on the revision bubble you wish to delete.

e From the Reviewing toolbar, click on the drop-down button
next to New Comment and click on Delete Comment.

E‘u New Comment L

Edit Comment

&P Delete Comment N

Comparing and merging two documents

Sometimes, you may send a document to a colleague for revision
and also continue working on that same document. In other cases,
two people in the same office may need to work on a document
simultaneously. Word allows multiple people to work on one
document at the same time, and later merge their changes into a
new composite document.

Working on a document that is already in use

e Open the document as you would open any other document in
Word.

e If the document has already been opened by another user, the
File in Use alert window will appear telling you that the
document is locked for editing.

e Click OK to create and open a copy of the document.

"Revising a Document - LG - 2-06-09.doc" is

\ being used by "another user". Do you want
L. W Y to make a copy?
.
[ Cancel ) (oK ‘)
i .3
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When the document opens, save the document by selecting
Save As from the File menu. The Save As window will
appear.

In the box labeled File Name, type a new name for the file.

0 Make sure you use a naming convention that will allow
you to recognize the file as the one you would like to
merge at a later time. We suggest using your name in
the title and a revision #. For example, Q4 Reports
(Revision 1-Joe).doc

Click on the button labeled Save.

| Save As: [Q4 Reports (Revision 1-Joe).doc ] E}
|
Where: | [] Revising a Document H
Format: [ Word 97-2004 Document (.doc) H

Description

The document format that is compatible with Werd 98 through Word 2004 for Mac and Word 97
through Word 2003 for Windows.

Learn more about file formats

3
W Append file extension
_r Options... \I r Compatibility Report... \I Compatibility check recommended
[ Cancel )

Type your changes and additions into the document as you
would any other document using the reviewing tools discussed
above.

Remember to save your changes when you are done working
on the document.
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Merging and comparing your documents

In order to merge two documents, you must be sure that you have
access to both revisions on your computer.

e Open one of the revised documents.

e From the Tools menu, select Merge Documents...

a:GIEN Table Window Work H

Spelling and Grammar... 3L
Thesaurus... ~NHR
Hyphenation...

Dictionary...

Language...

Word Count...
AutoSummarize...
AutoCorrect...

Track Changes >

P

rotect Document...
Flag for Follow Up...

¢ Navigate to the document you wish to compare with the one
that is currently open.
e Click on the name of the second document and click Open.

W

Choose file to merge into current document.

(<> (a8 élj‘E] [ £ Reports H'Qsearch

¥ DEVICES 7] Q4 Reperts (Revision 1-Joe).doc
= Macinto... B Q4 Reports.doc
Hl iDisk
=} Untitled

¥ SHARED —
@asiu... = 'DOC i
[] s adm... ———
@jn}e's iMac
ETSOS)(S » Name Q4

Pl 1l Reports.do

[ xrx000... v & Ty

Enable: [ Word Documents I-H

[: Cancel ) E Open a

A
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Word will merge the changes into this second document. The

changes will be displayed using red, underlined text.

XYZ Company — 4" Quarter Goals

* Wi
Finance _ : : . { 225109 10:35 AM [ T3

O Continue to diversify portfolio F Font:Eald

. ;

Marketing - R/25/09 10:35 AM o0

O Increase ad revenues in Northeast Formatted: Font:Bald
* QOperations 2/25/09 10:32 AM o0

Deleted! Midwes:

© Reduce costs ' /25/08 10:35 AM [

I‘ Font:Eald

* Technology

O Upgrade to Windows 7

4 2125/09 10:35 AM o0
Formatted: Font:Bold
2/25/09 10:34 AM o0
Deleted:! Vise

Sample of a document that has been compared with another document

The Reviewing toolbar will open automatically in the new

document.

You can accept and reject the changes in the newly merged

document using the Accept Change and Reject Change

buttons as explained earlier in this guide.

the merged document, save it with a new name.

10

When you are finished accepting and rejecting the changes in
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